
 

 

取 A-0133-05 

 

 

 

 

Fast optical DO sensor for integration 

 

RINKO FT 

(Model name: ARO-FT, AROD-FT) 

 

 

User’s Manual 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Use after thoroughly reading this manual. 
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Introduction 
 

 

 

 RINKO FT (model name: ARO-FT, AROD-FT) is a small, fast-response, and high-precision sensor for 

measurements of water temperature and dissolved oxygen (DO). 

 The communication method can be selected from UART (3.3V logic) and RS-232C according to the float 

specifications. 

 Possible to attach/detach the main unit without changing the float inner pressure for calibration/inspection.  

 Span/zero calibration is possible by the calibration kit (optional). 
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 1 Terminology and Part Names 
 

 

 Terminology 1.1

  

Term Description 

Instrument Refers to RINKO FT (ARO-FT/AROD-FT). 

Physical quantity 
Refers to values, such as water temperature and DO, calculated from the AD 

value with calibration coefficients. 

Standard type 

(ARO-FT) 
Refers to RINKO FT with standard mounting attachment. 

Cable type 

(ARO-FT) 
Refers to RINKO FT with LEMO connector. 

MCBH type 

(AROD-FT) 
Refers to RINKO FT with MCBH connector for deep sea (6700 m). 

 

  



 

3 

 

 Part names 1.2

 

 

 

 

 

 

 

 

 

 

 

 

  

Standard mounting attachment 

Insulation screw 

Figure 1.2 Cable type (ARO-FT) 

Figure 1.1 Standard type (ARO-FT) 

Main Unit 

Oxygen detection film 

Temperature sensor 

Lock-nut 

Locking sleeve 

LEMO connector 

Figure 1.3 MCBH type (AROD-FT) 

MCBH connector 
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 2 Package Contents 
 

 

 ARO-FT 2.1

 

(1) Basic Package 

 

No. Items QTY. 

1 ARO-FT main unit 
 

1 

2 Protection cap 
 

1 

3 

Standard mounting attachment 

or 

3m cable with LEMO connector and pigtail end 

 

1 

4 User’s Manual (this manual) 
 

1 

5 Calibration certificate 
 

1 

Note: the above list indicates the basic package. The content may differ depending on the order. 

 

(2) Optional parts 

 

No. Items QTY. 

1 Cable with LEMO connector and USB converter 
 

1 

2 Application CD 
 

1 

3 Bubbling kit 
 

1 

4 Mini-USB cable 
 

1 
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 AROD-FT 2.2

 

(1) Basic Package 

 

No. Items QTY. 

1 AROD-FT main unit 
 

1 

2 Protection cap 
 

1 

3 Dummy cap 
 

1 

4 User’s Manual (this manual) 
 

1 

5 Calibration certificate 
 

1 

Note: The above list indicates the basic package. The content may differ depending on the order. 

 

(2) Optional parts 

 

No. Items QTY. 

1 Cable with MCIL and D-sub 9 pin connectors 

 

1 

2 Application CD 
 

1 

3 Bubbling kit 
 

1 
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 3 Safety Warning 
 

 

 

 

 

    

Danger 

Indicate[s] a hazardous situation which, if not avoided, will result in 

death or serious injury. The signal word "DANGER" is to be limited to 

the most extreme situations. 

Warning 
Indicate[s] a hazardous situation which, if not avoided, could result in 

death or serious injury. 

Caution 
Indicate[s] a hazardous situation which, if not avoided, could result in 

minor or moderate injury. 

 
Indicates general precautions. 

 
Indicates supplements to control method and convenient functions. 

 

Danger 

 Ensure safety for operations on water or ships. 

 

Warning 

 Do not damage the cables. 

 Do not modify. 

 Do not use it with a power supply beyond the rated values. 

 Do not disassemble. 

It can cause fire or electrocution. 

 Do not directly look at the excitation light for a long time. 

It can damage the eyes. 

 

 

  

Make Sure to Read This before Use 
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Caution 

 Do not apply strong force or impact on the sensor. 

It can lead to damage, which may cause injury and seepage of water into the instrument. 

 Do not hang by holding only the lead wire. 

It can lead to a broken wire or damaged instrument. 

 Make sure to insert the connector completely up to its base. 

It may cause seeping of water into the instrument. 

 Do not leave the instrument in a place with high temperature (e.g. under direct sunlight) 

for a long time. 

It can accelerate the degradation of the oxygen detection film. 

 When attaching, make sure to tighten the screw all the way. 

Loosely attached screws can compromise the water-proof property and may cause seeping of 

water into the instrument. 
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 4 Precautions for Usage 
 

 

 Use of instrument 4.1

 

(1) This is a group 1, class B product according to EN 55011 (CISPR 11). This means that this product does 

not generate and/or use intentionally radio-frequency energy, in the form of electromagnetic radiation, 

inductive and/or capacitive coupling, for the treatment of material or inspection / analysis purpose and 

that it is suitable for use in domestic establishments and in establishments directly connected to a low 

voltage power supply network which supplies buildings used for domestic purposes. 

(2) This instrument is designed for residential and commercial environment. Not permitted to use for 

industrial environment. 

(3) After every use, clean with fresh water, remove moisture with a soft cloth, and store securely. 

(4) Please do not touch the temperature sensor directly. It may damage the sensor. Static electricity may 

damage the parts used for this instrument. Take countermeasures to prevent damage from static 

electricity during maintenance and others since it may damage the instrument. 

(5) The oxygen detection film is highly delicate and requires handling with care. Significant damage causes 

inaccurate data and requires a replacement of the oxygen detection film. 

(6) When not in use, place the protection cap and turn off the power supply. 

(7) Do not drop the instrument or apply impact. 

(8) Before touching the instrument, release static electricity by touching a metal. 

(9) As storage location, avoid places with temperature above 40 °C, high humidity, or high amount of dust. 

(10) If the instrument was not used for a long time, inspect each part before connecting to the power supply. 

(11) When using the instrument in water, it is recommended to use it at 30 °C or below. When it is used in 

water at 30 °C or above, the tracking for correction of temperature change can slow down, requiring 

more time to resume to the normal value. 

(12) The insulation screw is for preventing electrolytic corrosion due to contacts between different metals. 

(13) Use cables included with the instrument or specified cables only, and follow the use method specified in 

the manual when deploying the instrument. Using this instrument in any way not described in this 

manual may reduce the effectiveness of the instrument’s protective functions. In case of replacing any 

parts and/or consumables, please make sure to use those specified by our company. Please feel free to 

contact us with any questions. 

Cable list for ARO-FT 

No. Interface Max. Cable Length, Shielding Cable classification 

1 DC Input/RS-232C port 3m, shielded Signal and DC Power Line 

2 DC Input/RS-232C/UART port 1m, Un-shielded Signal and DC Power Line 

Cable list for AROD-FT 

No. Interface Max. Cable Length, Shielding Cable classification 

1 DC Input/RS-232C port 1.5m, Un-shielded Signal and DC Power Line 
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 Software 4.2

(1) It is prohibited to copy or reproduce part or whole of the software without JFE Advantech’s written 

approval. 

(2) The content and specifications may change without notice. 

(3) We try our utmost to comprehensive content, but please contact JFE Advantech for any suspicion or 

suggestions. 

(4) In this user’s manual, Microsoft® Windows® 7, Windows 8, Windows 8.1 are used for demonstrations. 

Computer’s control display or method may be different depending on the environment used. 

 Windows® official name is Microsoft® Windows® Operating System. 

 Microsoft® Windows®, Windows vista / 7 / 8 / 8.1 / 10 , .NET Framework are registered 

trademarks of Microsoft Corporation in the United States and other countries. 

 

 Disposal 4.3

When disposing of this product, ensure to abide by law and regulations. 
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5 Method for Connection 
 

 Wiring 5.1

5.1.1 Standard type (ARO-FT) 

The wire color varies depending on the communication method, UART (3.3V logic) or RS-232C. Make 

the connection after checking the communication method. 

(RX and TX are from the instrument side.) 

Color UART (3.3 V logic) RS-232C 

Red Power input (6 - 26 VDC) 

Black GND 

Green FG (
1
) 

Yellow N.C. (
2
) RX 

White N.C. (
2
) TX 

Blue RX (
3
) N.C. (

2
) 

Grey TX N.C. (
2
) 

5.1.2 Cable type (ARO-FT) 

The Cable type is only for RS-232C communication. 

(RX and TX are from the instrument side.) 

Green RS-232C 

Red Power input (6 - 26 VDC) 

Black GND 

Green FG (
1
) 

Yellow RX 

White TX 

5.1.3 MCBH type (AROD-FT) 

     The MCBH type is only for RS-232C communication.  

(RX and TX are from the instrument side.) 

Pin No. RS-232C 

1 N.C. (
1
) 

2 RX 

3 TX 

4 N.C. (
1
) 

5 FG (
2
) 

6 N.C. (
1
) 

7 GND 

8 Power input (6 - 26 VDC) 

  Note (
1
): Do not connect wires to N.C. ports. It can damage the instrument. 

Note (
2
): FG (Frame Ground) to protect the instrument from noises coming from the outside, which 

will be connected to the frame of the platform. It could also be connected to GND if necessary. 

Note (
1
): FG (Frame Ground) to protect the 

instrument from noises coming from the 

outside, which will be connected to the frame 

of the platform. It could also be connected to 

GND if necessary. 

Note (
2
): Do not connect wires to N.C. ports. 

It can damage the instrument. 
Note (

3
): 100 kΩ pull-down 

Note (
1
): FG (Frame Ground) to protect the instrument 

from noises coming from the outside, which will be 

connected to the frame of the platform. It could also 

be connected to GND if necessary. 
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 Attaching and detaching the attachment/connectors 5.2

5.2.1 Standard type (ARO-FT) 

 

(1) How to attach 

 

 

 Make sure that the O-rings are free of dust. 

 Insert slowly so as not to warp or pinch the O-rings. 

 Before use, check if the connector is inserted to the point you cannot turn it any more. 

Incomplete insertion can cause damage to the instrument due to the seepage of water. 

 

(2) How to detach 

     Pulling out the hex bolts disassembles the lock-nuts, then you will be able to detach. 

     Before attaching again, apply adequate amount of grease on the O-rings. 

 

 
 When detaching, hold the metal part and pull it out. Pulling only the cable can break it. 

 

Insert the connector into the main unit until two black 

O-rings are completely hidden. Hold it in while going to 

the next step. 

Attach a half of the two lock-nuts, while pushing the connector and the main unit towards to each 

other. When you do so, make sure that the red O-ring is squashed (almost invisible) by the connector 

and the main unit. 

       

                                                   Red O-ring is completely exposed. 

    

               Gap: approx. 0.5 mm 

While holding them together, place two lock-nuts and 

temporary fix the position by using two hex-bolts 

(M3×10) just enough to combine two lock-nuts into 

one. Screw the Lock-nut tightly onto the main unit to 

the point you cannot turn it any more. Then, tighten the 

two hex bolts completely. 

OK NG 
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5.2.2 Cable type (ARO-FT) 

 

(1) How to attach 

 

 

 Make sure that the O-rings are free of dust. 

 Insert slowly so as not to warp or pinch the O-rings. 

 Before use, check if the connector is inserted up to its base. Incomplete insertion can 

cause damage to the instrument due to the seepage of water. 

 

(2) How to detach 

It can be pulled out by loosening the locking sleeve. 

Before attaching again, apply adequate amount of grease on the O-rings. 

 

 
 When detaching, hold the metal part and pull it out. Pulling only the cable can break it. 

    

Insert the connector into the main unit until two black 

O-rings are completely hidden. Hold it in while going to 

the next step. 

 

Tighten the locking sleeve up to its base while pushing the 

connector against the main unit (see below). 

Check if the screw thread is completely hidden. 

       

            Thread is completely hidden.                 Thread is visible. 

OK NG 
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5.2.3 MCBH type (AROD-FT) 

 

(1) How to attach 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Before use, check if the connector is inserted up to its base. Incomplete insertion can 

cause damage to the equipment. 

 

 

(2) How to detach 

It can be pulled out by loosening the locking sleeve. 

Before attaching again, apply adequate amount of grease on the O-rings. 

 

 
 When detaching, hold the connector and pull it out. Pulling only the cable can break it. 

 

 

 

 

  

    

Insert the connector into the main unit until 

there is no gap between. 

 

Tighten the locking sleeve up to its base while 

pushing the connector into the main unit. 
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 6 Maintenance and Inspection 
 

 

 Before use 6.1

(1) Check that the sensor surface is free of any foreign object. 

(2) Check that there is no loose or damaged connector or screw. 

(3) Span/zero calibration is recommended before use. 

(4) Make sure to remove the protection cap before use. 

 

 Maintenance after use 6.2

(1) After use, clean well with fresh water. If something cannot be removed by water, gently remove it with a 

soft cloth. Rubbing it hard can damage the oxygen detection film. 

(2) After water cleaning, remove the moisture either by an air blower or by wiping with a soft cloth. 

(3) Check if there is no scratch or damage on the sensor. 

   

 Storage 6.3

(1) For storing, avoid places with high temperature, high humidity, or direct sunlight. 

(2) Place the sensor protection cap when storing in order to protect the sensor and prevent degradation. 

(3) Avoid places with temperature higher than 40 °C as it can cause output error or degradation of the 

oxygen detection film. 
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7 Span/zero Calibration (optional) 
 

 

Span/zero calibration is available using the calibration kit (option). 

 

 Installation of software 7.1

 Install the RINKO FT calibration software, FT-Calib, on your PC. 

 

(1) Insert the attached CD into the CD-ROM drive of the computer. 

(2) Installation starts automatically, go to (5). If it does not start, go to (3). 

(3) Open [Computer] from the start menu, and select the drive with the CD-ROM. 

(4) Double-click “setup.exe”. 

(5) Screens are displayed in the following order. Follow the guidance to install the software. 

 

After the installation is completed, the “FT-Calib” icon appears on the desktop and in the start menu [All 

Programs > JFE Advantech > FT-Calib]. 

 

 

  

(1) Preparing to install (2) [Next >] 

(3) Start installation by clicking [Install]. (4) Installing 
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 If the OS is Windows Vista or later, User Account Control (UAC) dialog may be 

displayed during installation for security. 

 If UAC dialog appears, select [Yes] to continue the installation. 

 UAC dialog might not appear depending on the computer setup, but this is not 

abnormal. 

 

 

 

 

 

 

 

 

 

 

 

  

(5) Complete the installation by clicking [Finish]. 

“FT-Calib” icon 
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 Installation of driver 7.2

 

(1) The screen below will be displayed if the interface is connected to the computer. 

 

 

(2) The driver needs to be installed if it displays the screen below. Follow the steps below.     

Following procedures are not necessary if the driver is properly installed. 

 

 

(3) Open [Control Panel] from start menu and click [Hardware and Sound]. 

 

 

(4) Click [Device Manager]. 
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(5) If the driver cannot be installed, there will be an item with [!] mark as shown below. 

 

 

(6) Right-click the item with the [!] mark and click [Update Driver Software…] 

 

 

(7) Click [Browse my computer for driver software]. 

 

 

(8) Click [Browse…] button and select the CD-ROM or the [ARO-FT Driver] folder inside where 

“FT-Calib” folder was installed. After selecting, click the [Next] button. 
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(9) If it displays the screen below, click [Install this driver software anyway]. 

 

 

(10) If it displays the screen below, you have succeeded with the driver installation. 

Check the Device Manager to make sure that the marks such as [!] and [?] have disappeared. If the 

marks are still present, try the same procedure again. 
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 How to communicate with the instrument 7.3

 

(1) Connect the instrument to the LEMO connector and connect the USB converter to the PC via USB 

cable. 

(2) Check the Device Manager to see which port the instrument is connected to. 

(a) Display Device Manager. 

 

 [Start > Control Panel], [Hardware and Sound > Device Manager] (if it is “View 

by: Category”) 

 Right-click [Start > Computer] and search [Properties], [Device Manager] 

 

(b) Check “Port (COM and LPT)”. 

 

 

 

 

 

 

 

 

(3) Start the specialized software “FT-Calib” (see 7.4.1). 

(4) Search for the instrument by clicking on [Auto detect] button. Please select the port searched by using 

device manager in case it cannot be searched. In case the port cannot be found, re-search for ports on 

your PC by clicking on [   ] button. Baud rate default is 38400.  

 

 

 

 

 

 

 

(5) It is possible to obtain the header information and check the connection by clicking the “Receive Header” 

button. 

 

 

 

  

Port to be used 

(COM4 in this case) 

 

Select Port Search for available ports 

Select baud rate 

Automatically detect the instrument 
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 How to use the software 7.4

7.4.1 Start the software 

 

The software can be started by the following method. 

 

(1) Start from the Start button. 

(1) Select [Start > All Programs > JFE Advantech > FT-Calib > FT-Calib]. 

(2) The software starts. 

 

(2) Double-click the icon on Desktop. 

(1) Double-click the [FT-Calib] icon on Desktop. 

(2) The software starts. 

 

 

 

 

 

 

7.4.2 Close the software 

 

The software can be closed by the following method. 

 

(1) Close from the [File] menu. 

The software closes when selecting [File > Close]. 

 

(2) Close by the [×] button on the title bar. 

The software closes when clicking the [×] button. 

 

 

 The data in calibration process will be deleted once you close the software. 

Confirm that there will be no problem before closing the software. 

 The software cannot be closed during communication processes. Close either after 

stopping the communication process or after completing the process. 
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 How to calibrate the instrument 7.5

 

Calibration procedure is described below. 

① Prepare the instrument and connect it to the computer. 

② Start the software (see 7.4.1) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

③ Set calibration settings (see 7.5.3). 

④ Connect to the instrument by clicking the [Connect] button. 

⑤ Sparge air into water while stirring for more than 30 minutes (using a stirrer is recommended). Place the 

DO sensor in air-sparged water and wait until the value stabilizes. 

 

 

 

 

 

⑥ When the value stabilizes, click the [OK] button and obtain the value. The value can be obtained as 

many times as desired. 

⑦ Next, place the DO sensor in a sodium sulfite solution (see 7.5.2) and obtain the value in the same way. 

Measure while slowly turning the instrument so as not to make bubbles. Place the tip of the sensor 

approximately 3 cm above the bottom. Note that after pushing [OK] for the zero calibration, it is not 

possible to return to the span calibration. 

 

 

 

 

 

 

④⑧ 

⑧ 

③ 

⑥ 

⑨ 

⑦ 
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⑧ When all the values are obtained, a new constant is calculated. After finishing the communication by 

clicking the [Disconnect] button, save the calibration value by clicking the [Write] button. 

⑨ Delete all the values by clicking the [Retry] button and restart the calibration. 

 

     

 

 Carry out this process with care as it affects physical quantities. 

 Make sure to complete the span calibration first. 

 Even if communication is stopped during calibration, it can be continued. 

 Displays a warning sign if calibration was failed. Recalibrate if the warning was 

displayed. 

 Unable to reverse once the new constant is saved. 

 Consider replacing the sensor film if the value is not calibrated. 

 

 

7.5.1 How to make air-sparged water for SPAN calibration 

 

 

 

 

 

 

7.5.2 How to make sodium sulfite solution for zero calibration 

Make the sodium sulfite solution (referred to as Na2SO3 solution) for zero calibration by the below 

process. Please note that JFE Advantech does not provide a sodium sulfite outside of Japan. 

        

 

 

 

 

 

 

 

 

  

Air-sparged water 

(Air-saturated 

water) 

Sparge air into 500 mL of water while stirring for more than 30 

minutes. 

Na2SO3 solution Dissolve 25 g of sodium sulfite in 500 mL of water. 

 If Na2SO3 solution enters eyes or mouth, immediately stop the operation 

and apply appropriate treatment according to the Safety Data Sheet (SDS). 

 If Na2SO3 solution touches the skin, immediately wash it off with large 

amount of water. 

 When disposing used solutions, do so appropriately according to the SDS. 

Caution 
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7.5.3 Calibration Setting 

 

Note that the items for setting differ depending on the reference materials used for calibration. 

 

 

  

 

 

 

Item Description 

Air saturated water 
This calibration uses air-sparged water as the reference. Input 

[Atmospheric Pressure] at the time of calibration. 

RMDO (Reference Material DO) 

(Under development) 

A reference material can be used for calibration, which is 

under development as of May 2016. Input the values 

displayed on the label of the reference material into the 

[RMDO] and [Salinity]. 
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 Other functions of the software 7.6

7.6.1 Update the firmware 

 

This updates the internal program of the instrument.  

We will distribute updated files via our website or individually. 

Updating takes about 5 minutes.  

If the firmware update fails, the instrument will become unusable.  

Update the firmware with care. 

 

① Start the software “FT-Calib” (see 7.4.1). 

② Select [Tools > Firmware Update] and open [Firmware Update]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

③ Check the version. If it fails to obtain the version, it can be obtained by clicking the [Refresh] 

button. 

④ Click the [Select] button to select the file to be updated. 

⑤ After clicking the [Start] button, two confirmation screens will appear. Click the [OK] button to 

start the update. 

⑥ Restart the instrument and check the instrument information after completing the update. 

 

 

 Never turn off the power or disconnect cables during the update. 

 Before updating the firmware, check the contents of our website or announcement 

before updating the firmware. 

 If the firmware update fails, the instrument will become unusable. Update the 

firmware with care. 

 If the update of firmware fails and the instrument is disabled, contact JFE Advantech. 

 

③ 

④ 

⑤ 
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7.6.2 Check the software version 

 

The software version can be checked. When there is any problem, inform JFE Advantech about the 

problem and the version information. 

 

(1) Start the software “FT-Calib” (see 7.4.1). 

(2) Select [Help > Version information]. The [Version information] window will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 The content and specifications may change for correction and improvement without 

notice. 

 We try our utmost to comprehensive content, but please contact JFE Advantech for any 

suspicion or suggestions. 

 For other handling, refer to Section 4. 
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 Change the software settings 7.7

 

The settings of software’s system and communication can be updated. 

   

(1) Start the software “FT-Calib” (see 7.4.1). 

(2) Select [Tools > Option]. The [Option] window will be displayed. 

 

 

 

 

 

 

 

 

 

 

(3) Change the settings as needed. Display the log information with the [View log] button (see 7.7.1) 

(4) Click the [OK] button to save the setting. Click the [Close] button to close without saving. 

 

Item Description 

Log Folder The folder where the logs of calibration and communication are saved. 

Timeout 
Time length of response to communication commands. If time-out occurs 

frequently, set this value longer (default: 3 seconds). 

Show caution of 

startup 

Shows a caution of startup (see 7.7.2) when starting the software (default: 

ON). 

 

 

 Depending on the change in the setting, the functionality of the instrument can 

change significantly. Change the settings with great caution. 

 Carefully examine the functionality of the instrument after changing the 

settings. 

 

  



 

28 

 

 

7.7.1 Browse the log 

 

Logs of calibration and communication can be browsed. The log information is displayed by clicking 

the [View Log] button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) After selecting the log to browse, its date of creation is displayed. 

(2) After selecting the date to browse, the logs are displayed. 

 

 

7.7.2 Display of precautions for calibration 

 

A caution for calibration is displayed when starting the software. The display of the caution can be 

changed by Option (see 7.7). 

 

 

 

 

 

 

 

 

 

 The display closes automatically in 5 seconds. 

 If you check the [Do not show next time] box, the caution will not be displayed from 

the next time the software is started. 

 The countdown stops when [Do not show next time] is changed. 

  

(1) Select the type of log 

(2) Select the date 
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 Uninstallation of the software 7.8

 

The software can be uninstalled in one of two ways below. 

 

7.8.1 Uninstall using the Start Menu 

 

① From the Start Menu, select [All Programs > JFE Advantech > FT-Calib] and click [Uninstall]. 

② Uninstall by following the guidance. 

 

7.8.2 Uninstall using the Programs and Features 

 

① From Start menu, click [Control Panel]. 

② From the [Control Panel] window, select [Programs and Features]. 

③ Select “FT-Calib” from the list by clicking it, and click [Uninstall] in the upper part of the window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

④ Screens are displayed in the following order. Uninstall according to the guidance. 

(1) Click [Yes] 

 

 

 

(2) The uninstallation is completed when the progress window closes. 

 

  

(2) Click Uninstall 

(1) Click “FT-Calib” 
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8 Calculation of Physical Values 
 

 

Hexadecimal AD values of temperature, DO, and LED accumulated time obtained by commands “tdon”, 

“tdona”, “stdon”, or “stdona” should be converted to decimal values before the calculation of physical 

values. See also Chapter 8 in Appendix 1. 

 

 Temperature calculation 8.1

 

Temperature (𝑇) in °C is calculated from the equation below: 

 

𝑇 = 𝐴 + 𝐵 × 𝑁 + 𝐶 × 𝑁2 + 𝐷 × 𝑁3 + 𝐸 × 𝑁4 + 𝐹 × 𝑁5 

 

𝑇:    Temperature [°C] 

𝐴, 𝐵, 𝐶, 𝐷, 𝐸, 𝐹:  Calibration coefficients 

𝑁:    AD value of T 

 

 Oxygen calculation and compensation 8.2

 

The calibration for this instrument uses traceable reference gases according to the Japanese national standard. 

The calibration coefficients (𝑐0 − 𝑐2, 𝑑0 − 𝑑4, and 𝑒0) are derived from 16 calibration points (4 temperature 

points and 4 oxygen concentrations in freshwater). The oxygen concentration (𝐷𝑂) in μmol L
-1

 is calculated 

from the equation below: 

 

𝐷𝑂 = {(
1 + 𝑑0 ∙ 𝑇

𝑑1 + 𝑑2 ∙ 𝑁 + 𝑑3 ∙ 𝑡 + 𝑑4 ∙ 𝑡 ∙ 𝑁
)

𝑒0

− 1} ∙
1

𝑐0 + 𝑐1 ∙ 𝑇 + 𝑐2 ∙ 𝑇2
 

Uchida et al. (2010) 

 

𝐷𝑂:      Dissolved Oxygen [μmol L
-1

] 

𝑐0 − 𝑐2, 𝑑0 − 𝑑4, 𝑒0: Calibration coefficients 

𝑇:    Temperature [°C] 

𝑁:    (AD value of DO) / 10000 

𝑡 :    LED accumulated time [s] (see Chapter 8 in Appendix 1) 

 

The pressure-compensated oxygen concentration (𝐷𝑂pc) in μmol L
-1

 is calculated from the equation below: 

 

𝐷𝑂pc = 𝐷𝑂(1 + 𝐶𝑝𝑝) 

 

   𝑝:    Pressure [MPa] 

   𝐶𝑝:  Calibration coefficient 
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The salinity-compensated oxygen concentration (𝐷𝑂sc) in μmol kg
-1

 is calculated by multiplying the factor of 

the effect of salt on the oxygen solubility (Benson and Krause 1984, García and Gordon 1992). The salinity 

& pressure-compensated oxygen concentration can be calculated by using 𝐷𝑂pc in the following equation: 

 

𝐷𝑂sc = 𝐷𝑂pcexp[𝑆(𝐵0 + 𝐵1𝑇𝑠 + 𝐵2𝑇𝑠
2 + 𝐵3𝑇𝑠

3) + 𝐶0𝑆2] 

 

𝑇𝑠 = ln (
298.15 − 𝑇

273.15 + 𝑇
) 

𝑇:  Temperature [°C] 

𝑆:  Salinity [‰ or PSU] 

 

 

 

The oxygen concentration is in gravimetric units (μmol kg
-1

), and can be obtained by dividing the volumetric 

unit (μmol L
-1

) by the potential density from the CTD data(making sure to convert kg m
-3

 to kg L
-1

 

beforehand)
 
. 

Note that the physical value output of the instrument does not consider salinity and/or pressure. The user 

should correct the output afterwards. 

  

𝐵0 = - 7.01577 × 10
-3 

𝐵1 = - 7.70028 × 10
-3 

𝐵2 = - 1.13864 × 10
-2 

𝐵3 = - 9.51519 × 10
-3 

𝐶0 = - 2.75915 × 10
-7
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9 Troubleshooting 
 

 Main unit 9.1

 

Problem Action 

Unable to communicate 

 Check if the power supply voltage is 6 – 25 VDC. 

 Check the connectors’ connection. 

 Turn the instrument off and on again. Then try any command a few 

times. 

 If RS-232C communication is used, check if the communication line 

is active before turning on the power of the instrument. 

The measured values are 

unstable 

 If something is adhered on the sensor (e.g., bio-fouling), clean it by 

running water or a soft cloth. See Chapter 6. 

 Make sure that strong noise source is not in contact with the main unit 

or the lead wire. 

 Check if the measurement value is obtained after the preheat time   

(5 seconds). 

 Check if there is any large scratch on the oxygen detection film. 

 

 

 Calibration software 9.2

 

Problem Action 

Unable to install 

 The installer does not start after inserting the CD. 

 If the installer does not automatically start after inserting the CD, 

manually execute the installer file (see 7.1). 

 Unable to execute the installer. The installer does not start. 

 Check if the OS is compatible with the software (see 10.3). 

 Check if the CD-ROM drive of your computer is functioning 

properly. If the problem is not with the drive but with the CD, 

please contact JFE Advantech. 
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Problem Action 

Unable to start / 

Slow start-up 

 .NET Framework is not installed. 

 In order for the software to function, .NET Framework 3.5 SP1 or a 

later version needs to be installed on the computer (see 7.1). If it is 

not installed, download it from Microsoft’s website and install it. If 

your OS is Windows 7 or later, this process is usually not necessary. 

 Installation is not completed properly. 

 If installation was terminated during the process, the installation 

might be incomplete. If this is the case, uninstall the software first, 

and then reinstall it (see 7.1 and 7.8). 

 Slow software start-up. 

 Start-up can be slow depending on the specifications of the 

computer or .NET Framework. 

Unable to communicate 

with the instrument 

 The connection port is not set up. 

 Set up the connection port (see 7.3). 

 The connection port is wrong. 

 If the computer has multiple ports, a port which is not connected 

to the instrument may be set up. Confirm the port number (see 

7.3). 

 Time-out occurs frequently. 

 Set the time-out longer (see 7.7). 

 Check if the instrument and the computer is connected properly. 

 Header information is corrupted. 

 Communication may be disabled if the header information of the 

instrument is corrupted. The header information needs to be fixed. 

Please contact us. 

 Firmware update failed. 

 If the firmware update fails, the instrument is disabled, and so is 

the communication. If the update of the firmware fails, please 

contact us. 

Unable to close 

 Unable to close the software by [File > Close] or the [×] button. 

 The software cannot be closed during the recording of measured 

data or communication with the instrument for calibration. For 

logging, stop the recording of the measured data. For the 

calibration, disconnect the communication. 
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10 Specifications 
 

 Instrument specifications 10.1

   Note (
1
): UART (3.3 V logic) is available only for the standard type (ARO-FT). 

 Sensor specifications 10.2

Note (
2
): Calculated from air saturation at 25 °C and 34 PSU. 

Note (
3
): Temperature calibration range: 3 ‒ 30 °C 

Note (
4
): Accelerated degradation test. 

Note (
5
): Pressure hysteresis is not considered. 

Note (
6
): Typical value for immersing from air-saturated water with 25 °C to sodium sulfite solution. 

Power 6 ‒ 26 VDC (12 VDC recommended) 

Current drain (at 12 VDC) Operation mode: < 30 mA, Sleep mode: < 0.1 mA 

Communication (1) 
 UART (3.3 V logic), voltage range: 3.3V ±5% (3.135 ‒ 3.465 V) 

 RS-232C 

Communication protocol Baud rate: 14400, 19200, or 38400 bps (default), 8 data bits, 1 stop bit, No parity, Handshake 

AD converter 16 bit digital conversion 

Sampling interval 1 s 

Preheat time 5 s 

Model name ARO-FT AROD-FT 

Depth rating 2,000 m depth equivalent 6,700 m depth equivalent 

Material 
Housing: Titanium (grade 2) 

Insulation screw: POM 

Housing: Titanium (Ti-6Al-4V) 

Connector 8-pin LEMO Impulse MCBH-8-MP or SubConn MCBH8M 

Weight 
In air: approx. 183 g (main unit) 

In water: approx. 110 g (main unit) 

In air: approx. 265 g 

In water: approx. 175 g 

Parameter Temperature DO 

Principle Thermistor Phosphorescence 

Measurement range -3 ‒ 45 °C 
Oxygen concentration: 0 ‒ 425 µmol L-1 (2) 

Air saturation: 0 ‒ 200% 

Calibration range 0 ‒ 35 °C 
Oxygen concentration: 0 ‒ 255 µmol L-1 (2) 

Air saturation: 0 ‒ 120% 

Resolution 0.001 °C 0.01 µmol L-1 

Accuracy ±0.01 °C 

Initial accuracy: ± 2% of measured value or ±2.0 µmol L-1 (3) 

Sample-based drift: < ±5% of measured value or ±5.0 µmol L-1 / 4,000,000 samples (4) 

Pressure effect: < ±2% of measured value or ±2.0 µmol L-1 (5) 

Temperature effect: < ±2% of measured value or ±2.0 µmol L-1 

Response time (63%) < 1 s in water < 1 s in water (6) 
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 Software specifications 10.3

 

10.3.1 Recommend operational environment 

 

Item Specification 

OS 

Microsoft® Windows® XP SP3 or later (needs .NET Framework 3.5 SP1 or later) 

Microsoft® Windows® Vista SP2 or later (needs .NET Framework 3.5 SP1 or later) 

Microsoft® Windows® 7 SP1 or later (32 bit / 64 bit) 

Microsoft® Windows® 8 SP1 (32 bit / 64 bit) 

Microsoft® Windows® 10 (32bit / 64bit) 

CPU Intel Core i5 1.6 GHz or faster 

Memory 

Microsoft® Windows® XP: 512 MB or larger 

Microsoft® Windows Vista®: 1 GB or larger 

Microsoft® Windows® 7: 1 GB or larger (32 bit) / 2 GB or larger (64 bit) 

Microsoft® Windows® 8, 8.1: 1 GB or larger (32 bit) / 2 GB or larger (64 bit) 

Microsoft® Windows® 10: 2 GB or larger (32 bit / 64 bit) 

HDD 
Hard disk with space more than 1 GB 

(About 30 MB is needed for installation) 

Resolution 1024 × 768 pixels or greater 

Port USB × 1 

Other 

.NET Framework 3.5 SP1 or later (only for Microsoft® Windows® XP, Windows 

Vista, Windows 8 later) 

A drive for CD-ROM (necessary for installation) 

 Windows® official name is Microsoft® Windows® Operating System. 

 Microsoft Windows, Windows vista / 7 / 8 / 8.1 / 10, .NET Framework are registered trademarks of 

Microsoft Corporation in the United States and other countries. 

 Intel Core are registered trademarks of Intel Corporation in the United States and other countries. 

 

 

 The software is compatible with installation to 64 bit OS but operates on 32 bit. 

 Make sure the OS is updated by using Windows Update. 

 .NET Framework 3.5 SP1 can be obtained from the Microsoft website. 

 You will need internet access in case of installing .NET Framework 3.5 SP1 to PC with 

Windows 8 or later.  
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 Drawing 10.4

Dimensions are in mm. 

 

 

Figure 10.1 Standard type (ARO-FT) 

 

 

 

 

 

 

 

Figure 10.2 Mounting part of standard type (ARO-FT) 

  

Insulation screw and O-rings 

(Sensor side) 

Mounting hole 

(Platform side) 
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Dimensions are in mm. 

 

 

Figure 10.3 Cable type (ARO-FT) 

 

 

 

Figure 10.4 MCBH type (AROD-FT) 
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11 Warranty 
 

 

The warranty is provided for this product. 

 

(1) The warranty period is defined to be 1 year after the delivery of the product. During this period, if the 

problem is considered to be a design or manufacturing defect, or malfunction upon a normal condition, 

JFE Advantech will repair the product free of charge. 

(2) Scratches, stain, rust etc. on accessories, expendables, package, and exterior are out of warranty. 

(3) Note that fees are applied in the cases listed below even within the warranty period. 

a. Damage during installment, mooring, and storage 

b. Malfunction and damage caused by wrong operation or carelessness 

c. Malfunction and damage caused by improper repair and modification by a third party 

d. Malfunction and damage caused by shipment, fall, and impact after purchase 

e. Malfunction and damage due to external causes such as fire, earthquake, flood, lightening, 

other natural disasters, public nuisance, abnormal voltage, corrosive gas, organic solvent, and 

chemical solution 

f. Malfunction and damage caused by abnormality in other devices connected to the product 

g. For replacing the expendables 

h. Malfunction and damage caused by replacement of the expendables done by users (e.g. O-ring 

and wiper blade) 

i. Malfunction and damage caused by a third party’s product such as equipment and software 

(4) Note that JFE Advantech will not be held liable for damage caused by the use of the product, lost profit, or 

any claim by a third party. 

(5) Damage during installment or shipment is out of warranty. Consider obtaining insurance if such damage is 

of concern. 

(6) In case of repair, the warranty period is defined to be half year after the delivery of the repaired product. 

During this period, if the same problem happens again upon a normal condition, JFE Advantech will repair 

the product free of charge. 
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Appendix 1: Command Reference 
 

1 Communication Protocol 

Protocol: UART (3.3 V logic) or RS-232C 

Note: UART is available only for the standard type (ARO-FT). 

Baud rate: 14400, 19200, or 38400 (default) 

Data: 8 data bits 

Stop bit: 1 bit 

Parity: None 

2 Command Format 

When sending a command from Host Controller (hereinafter, HC) to RINKO FT, it sends the command in the following 

format. 

  Request,Checksum,<CR><LF> 

 When RINKO FT responds to a command from HC, it responds the command in the following format. 

  Response,Checksum,<CR><LF> 

 Description of Checksum: 

The checksum is the least significant byte of ones’ complement of the sum of the values of Request (or Response) and “,” 

(comma).  The checksum should be converted to 2-byte ASCII. 

Example: 

In case of a command “do,Checksum,<CR><LF>”, 0x64 + 0x6F + 0x2C = 0xFF, then take the ones' 

complement of 0xFF, which equals 0x00. Then 0x00 should be converted to 2-byte ASCII, which equals “00”, 

i.e., “do,00,<CR><LF>”. 

 

3 Sleep Mode and Precautions 

a) RINKO FT has a sleep mode. In sleep mode, the RINKO FT is in the following condition. 

 Analog electronics are powered OFF. 

 CPU is in low-power mode. 

 RINKO FT returns Error Code 0003 to the first command during the sleep mode. 

When receiving any command during sleep mode, the RINKO FT will send Error Code 0003 as its first 

Response (it will take a little time to respond in 1 second at maximum). Only the CPU will wake up (the 

analog electronics are still powered off) and start to appropriately accept any command. The CPU will 

enter low-power mode if it does not receive any command for 2 minutes. See also Chapter 5 for Error 

Code 0003. 

b) The DO output stabilizes 5 seconds after waking up or powering on RINKO FT (i.e., turning ON the analog power). 

In order to obtain a stable and reliable DO data, it is necessary to wait at least 5 seconds after wake-up or 

power-on for the first time. In this appendix, this period of time is referred to as “preheat time”. If the analog 

power is already ON for more than 5 s, it should be in normal operation mode and is not necessary to wait. The 

state of RINKO FT can be confirmed by the command “querys”. Refer to Chapter 0 for State. 

c) RINKO FT automatically enters sleep mode if it does not receive any command for 2 minutes. 

d) When turning off the power of RINKO FT, do so after the RINKO FT is in sleep mode if LED accumulated time is 

needed. 

The power can be turned off immediately after receiving the “qs” response. If the Checksum does not match or 

the “qs” response cannot be received when sending the “qs” command in order to turn off the power, retry up to 

three times. After failing three times, turn off the power. We STRONGLY RECCOMMEND to turn off the 

power of RINKO FT (i.e., OFF not only analog electronics but also CPU) instead of using sleep mode. 

If the RINKO FT is turned off without entering sleep mode, LED time is not accumulated appropriately.  

Nothing damages physically the RINKO FT. If LED accumulated time is not used, the RINKO FT can be 

turned off without entering sleep mode. 
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4 Commands 

HC to 

RINKO FT 

RINKO FT 

to HC 
Description   

Request Response Outline Detail 

do do,HEX 
Send DO, enter 

sleep mode. 

Turn ON the analog power (if it is in sleep mode), send the DO physical 

data [μmol/L], and enter sleep mode. If the RINKO FT analog power is 

OFF when receiving the command, it takes 5 seconds for the DO value to 

stabilize. For that reason, DO NOT USE this command during the sleep 

mode because the RINKO FT again enters sleep mode immediately after 

sending unstable/unreliable data. 

tdo 
tdo,HEX,HE

X 

Send T and DO, 

enter sleep 

mode. 

Turn ON the analog power (if it is in sleep mode), send the temperature and 

DO physical data [°C and μmol/L], and enter sleep mode. If the RINKO FT 

analog power is OFF when receiving the command, it takes 5 seconds for 

the DO value to stabilize. For that reason, DO NOT USE this command 

during the sleep mode because the RINKO FT again enters sleep mode 

immediately after sending unstable/unreliable data. The left and right HEXs 

represent temperature and DO, respectively. 

sdo sdo,HEX Send DO. 

Turn ON the analog power (if it is in sleep mode) and send the DO physical 

data [μmol/L]. If the RINKO FT analog power is OFF when receiving the 

command, it takes 5 seconds for the DO value to stabilize. 

stdo 
stdo,HEX,H

EX 
Send T and DO. 

Turn ON the analog power (if it is in sleep mode) and send the temperature 

and DO physical data [°C and μmol/L]. If the RINKO FT analog power is 

OFF when receiving the command, it takes 5 seconds for the DO value to 

stabilize. The left and right HEXs represent temperature and DO, 

respectively. 

tdon 
tdon,HEX,H

EX,HEX 

Send AD values 

of T and DO 

and LED time, 

enter sleep 

mode. 

Turn ON the analog power (if it is in sleep mode), and send the temperature 

and DO AD values and LED accumulated time, and enter sleep mode. If 

the RINKO FT analog power is OFF when receiving the command, it takes 

5 seconds for the DO value to stabilize. For that reason, DO NOT USE this 

command during the sleep mode because the RINKO FT again enters sleep 

mode immediately after sending unstable/unreliable data. The first HEX 

represents the temperature, the second the DO, and the third the LED 

accumulated time. 

tdona 

tdona,HEX,

HEX,HEX,

HEX,HEX,

HEX,HEX 

Send all 

parameters as 

AD values and 

LED time, enter 

sleep mode. 

Turn ON the analog power (if it is in sleep mode), send temperature and 

DO AD values, phases of the blue and red lights (AD values), amplitudes 

of the blue and red lights (AD values), and LED accumulated time, and 

then enter sleep mode. If the RINKO FT analog power is OFF when 

receiving the command, it takes 5 seconds for the DO value to stabilize. 

For that reason, DO NOT USE this command during the sleep mode 

because the RINKO FT again enters sleep mode immediately after sending 

unstable/unreliable data. The first HEX represents the temperature, the 

second the DO, the third the blue phase, the fourth the red phase, the fifths 

the blue amplitude, the sixth the red amplitude, and the seventh the LED 

accumulated time. 

stdon 
stdon,HEX,

HEX,HEX 

Send AD values 

of T and DO 

and LED time. 

Turn ON the analog power (if it is in sleep mode) and send the temperature 

and DO AD values and LED accumulated time. If the RINKO FT analog 

power is OFF when receiving the command, it takes 5 seconds for the DO 

value to stabilize. The first HEX represents the temperature, the second the 

DO, and the third the LED accumulated time. 

stdona 

stdona,HEX,

HEX,HEX,

HEX,HEX,

HEX,HEX 

Send all 

parameters as 

AD values and 

LED time. 

Turn ON the analog power (if it is in sleep mode) and send temperature and 

DO AD values, phases of the blue and red lights (AD values), amplitudes 

of the blue and red lights (AD values), and LED accumulated time. If the 

RINKO FT analog power is OFF when receiving the command, it takes 5 

seconds for the DO value to stabilize. The first HEX represents the 

temperature, the second the DO, the third the blue phase, the fourth the red 

phase, the fifths the blue amplitude, the sixth the red amplitude, and the 

seventh the LED accumulated time. 
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HC to RINKO FT RINKO FT to HC Description   

Request Response Outline Detail 

qs qs,OK Enter sleep mode. 

Enter sleep mode after returning a response. When 

turning off the power of the RINKO FT, do so after the 

RINKO FT is in sleep mode. 

*serialnumber *serialnumber=S Display serial number. 

The serial number of the RINKO FT. “S” is an ASCII 

string [0-9a-zA-Z]. The length of the string is 10 at 

maximum. 

dc 
(1)dc,OK 

(2)Coefficients 

Display calibration 

coefficients. 

(1) First, it gives a response to the command 

(Response=dc,OK). 

(2) Next, returns the calibration Coefficients. 

Refer to Chapter 7 for Calibration coefficients. 

wu wu,State Wakeup. 

Turn ON the analog power (if it is in sleep mode), and 

send current State of RINKO FT. Refer to Chapter 0 for 

State. See also Chapters 3-a and 5 for Error Code 0003. 

querys querys,State Display current state. 
Send the current State of RINKO FT. Refer to Chapter 0 

for State. 

fwver fwver=S 
Display firmware 

version. 

Send the firmware version of RINKO FT. “S” is a string, 

and its format is “Ver.X.XX”. 

model model=S Display model name. 
Send the model name of RINKO FT. “S” is a string. The 

string length is variable and maximum length is 16. 

baudrate=I baudrate=I Set baud rate. 

Set a baud rate of RINKO FT. "I" is an integer. The 

specified format is fixed "14400", "19200", or "38400" 

(default). If RINKO FT receives other than those, it 

responses error (Invalid parameter). New baud rate is 

available once RINKO FT is rebooted (i.e., power OFF 

and ON). 

– error=Error Code Error response Send the Error Code. Refer to Chapter 5 for Error Code. 

Note 1: RINKO FT returns Error Code 0003 to ANY FIRST COMMAND during the sleep mode. RETRY Request. 

Note 2: Retry Request if there is something strange, such as no response, error response, or unmatched Checksum. 

 

5 Error Code 

Error Code Description 

0001 The Request command could not be interpreted. 

0002 Checksum error. 

0003 

First response from the sleep mode. 

RINKO FT returns Error Code 0003 to any first command (even if it is “wu”) while it is in the sleep 

mode. After the Error Code 0003, only the CPU wakes up and starts to accept any command 

appropriately. Therefore, please RESEND the same Request. If the RINKO FT does not receive any 

command for 2 minutes, the CPU will enter the low-power mode again. See also Chapter 3. 

0004 Invalid parameter. 
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6 State of RINKO FT 

State Description 

normal 

RINKO FT is in normal operation mode. 

In this state, RINKO FT continuously measures and updates data every 1 s (but does not output/record 

data). When receiving a command to output data, RINKO FT outputs the latest data. 

preheat 

RINKO FT is in preheat state. 

RINKO FT is already waked up, but the sensor is preheating. In this state, measured DO is unstable and 

unreliable. 

sleep 
RINKO FT is in sleep mode. 

In this state, the analog electronics power is OFF and the CPU is in low-power mode. See also Chapter 3. 

 

7 Calibration Coefficients 

Coefficients Description 

C0=F C0 coefficient (Uchida et al., 2010). “F” is a real number. 

C1=F C1 coefficient (Uchida et al., 2010). “F” is a real number. 

C2=F C2 coefficient (Uchida et al., 2010). “F” is a real number. 

d0=F d0 coefficient (Uchida et al., 2010). “F” is a real number. 

d1=F d1 coefficient (Uchida et al., 2010). “F” is a real number. 

d2=F d2 coefficient (Uchida et al., 2010). “F” is a real number. 

d3=F d3 coefficient (Uchida et al., 2010). “F” is a real number. 

d4=F d4 coefficient (Uchida et al., 2010). “F” is a real number. 

Cp=F Cp coefficient (Uchida et al., 2010). “F” is a real number. 

e0=F e0 coefficient (Uchida et al., 2010). “F” is a real number. 

FilmNo=S Film number “S” is an ASCII string [0-9a-zA-Z]. The length of the string is 8. 

docaldate=S Date of calibration for DO sensor. The format of “S” is “YYYY/MM/DD”. 

A=F Temperature A coefficient. “F” is a real number. 

B=F Temperature B coefficient. “F” is a real number. 

C=F Temperature C coefficient. “F” is a real number. 

D=F Temperature D coefficient. “F” is a real number. 

E=F Temperature E coefficient. “F” is a real number. 

F=F Temperature F coefficient. “F” is a real number. 

G=F Temperature G coefficient. “F” is a real number. 

H=F Temperature H coefficient. “F” is a real number. 

tcaldate=S Date of calibration for temperature sensor. The format of “S” is “YYYY/MM/DD”. 

 

Example of command for calibration coefficients: 

 dc,OK,46,<CR><LF> 

 C0=3.24923E-03,E9,<CR><LF> 

 C1=1.40598E-04,E5,<CR><LF> 

 … 

 docaldate=2013/05/21,09,<CR><LF> 

 A=2.345,59,<CR><LF> 

 B=13.66666,B4,<CR><LF> 

 … 

  tcaldate=2013/05/21,68,<CR><LF> 
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8 Data Format 

 HEX data format for commands “do”, “tdo”, “sdo”, and “stdo”; 

 The HEX format is extracted as follows. 

 Temperature in physical value 

HEX=TTTT 

TTTT is a value for temperature and four-letter HEX value. 

Temperature [℃] =  
(decimal expression for TTTT)

1000
− 5 

If temperature < -5.000, then set 0000 to TTTT. 

If temperature > 40.000, then set FFFF to TTTT. 

 DO in physical value 

HEX=DDDD 

DDDD is a value for DO and four-letter HEX value. 

DO [μmol L−1] =  
(decimal expression for DDDD)

100
 

If DO > 425.00, then set FFFF to DDDD. 

 

 HEX data format for commands “tdon”, “tdona”, “stdon”, and “stdona”; 

 The HEX format is extracted as follows. 

 Temperature in AD value 

HEX is between 0000 and FFFF. 

Fixed length of 4 

 DO in AD value 

HEX is between 0000 and FFFF. 

Fixed length of 4 

 LED accumulated time 

HEX is between 00000000 and FFFFFFFF. 

Fixed length of 8 

LED accumulated time is expressed by a factor of 10 ms, e.g. the decimal value “5” corresponds to 50 ms. 

LED accumulated time in seconds is calculated by the equation below: 

LED accumulated time [s] =  
(decimal expression for LED accumulated time)

100
 

   

 “I” data format 

 “I” represents integer. 

   

 “F” data format 

 “F” represents real number. 

  “F” is variable-length and 16 at maximum. 

 

9 Miscellaneous 

 The GND terminal for RS-232C is same with that of the power supply. 

 For RS-232C connection, establish the communication line before turning on the power of the RINKO FT. 

 For UART connection, use same GND terminal for both the RINKO FT power GND and the HC transceiver IC. 

 Phase/amplitude data are utilized by the instrument to internally calculate the AD values of DO. Phase/amplitude AD 

values are for an easy diagnostic at factory in case of trouble. 
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Appendix 2: Command Summary 

 

 

  

0 1 2 3 4 5 6 7

1 do Request 'd' 'o' ',' ',' CR LF 0x00

0 1 2 3 4 5 6 7 8 9 10 11 12

2 do,HEX Response 'd' 'o' ',' Hex=DO ',' ',' CR LF DO 4 unfixed DO physical value

0 1 2 3 4 5 6 7 8

3 tdo Request 't' 'd' 'o' ',' ',' CR LF 0x8C

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18

4 tdo,HEX,HEX Response 't' 'd' 'o' ',' Hex=Temp ',' Hex=DO ',' ',' CR LF Temp 4 unfixed T. physical value

DO 4 DO physical value

0 1 2 3 4 5 6 7 8

5 sdo Request 's' 'd' 'o' ',' ',' CR LF 0x8D

0 1 2 3 4 5 6 7 8 9 10 11 12 13

6 sdo,HEX Response 's' 'd' 'o' ',' Hex=DO ',' ',' CR LF DO 4 unfixed DO physical value

0 1 2 3 4 5 6 7 8 9

7 stdo Request 's' 't' 'd' 'o' ',' ',' CR LF 0x19

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

8 stdo,HEX,HEX Response 's' 't' 'd' 'o' ',' Hex=Temp ',' Hex=DO ',' ',' CR LF Temp 4 unfixed T. physical value

DO 4 DO physical value

0 1 2 3 4 5 6 7 8 9

9 tdon Request 't' 'd' 'o' n' ',' ',' CR LF 0x1E

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14

10 Response 't' 'd' 'o' n' ',' HEX=Temp ',' HEX=DO ',' Temp 4 unfixed T. AD value

DO 4 DO AD value

15 16 17 18 19 20 21 22 23 24 25 26 27 28 LED 8 LED accumulated time

HEX=LED ',' ',' CR LF

0 1 2 3 4 5 6 7 8 9

11 tdona Request 't' 'd' 'o' n' a' ',' ',' CR LF 0xBD

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

12 Response 't' 'd' 'o' n' a' ',' HEX=Temp ',' HEX=DO ',' HEX=Phase (B) ',' Temp 4 unfixed T. AD value

DO 4 DO AD value

21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 Phase(B) 4 Blue phase AD value

HEX=Phase (R) ',' HEX=Amplitude(B) ',' HEX=Amplitude(R) ',' Phase(R) 4 Red phase AD value

Amplitude(B) 4 Blue amp. AD value

36 37 38 39 40 41 42 43 44 45 46 47 48 49 Amplitude(R) 4 Red amp. AD value

HEX=LED ',' ',' CR LF LED 8 LED accumulated time

No. Command Type Command format Data
Data

length

Check-

sum
Description

Physical value AD value LED

accumulated

time

Enter

sleep

mode

Temp.

[°C]

DO

[μmol/L]
Temp. DO

Phase Amplitude

Blue light Red light Blue light Red light

Checksum

✔ ✔

Checksum

Checksum

✔ ✔ ✔

Checksum

Checksum

✔

Checksum

Checksum

✔ ✔

Checksum

Checksum

tdon,HEX,

HEX,HEX

✔ ✔ ✔ ✔

Checksum

Checksum

tdona,HEX,

HEX,HEX,

HEX,HEX,

HEX,HEX

✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Checksum
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0 1 2 3 4 5 6 7 8 9 10

13 stdon Request 's' 't' 'd' 'o' n' ',' ',' CR LF 0xAB

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

14 stdon,HEX, Response 's' 't' 'd' 'o' n' ',' HEX=Temp ',' HEX=DO ',' Temp 4 unfixed T. AD value

HEX,HEX DO 4 DO AD value

16 17 18 19 20 21 22 23 24 25 26 27 28 29 LED 8 LED accumulated time

HEX=LED ',' ',' CR LF

0 1 2 3 4 5 6 7 8 9 10 11

15 stdona Request 's' 't' 'd' 'o' n' a' ',' ',' CR LF 0x4A

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21

16 Response 's' 't' 'd' 'o' n' a' ',' HEX=Temp ',' HEX=DO ',' HEX=Phase (B) ',' Temp 4 unfixed T. AD value

DO 4 DO AD value

22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 Phase(B) 4 Blue phase AD value

HEX=Phase (R) ',' HEX=Amplitude(B) ',' HEX=Amplitude(R) ',' Phase(R) 4 Red phase AD value

Amplitude(B) 4 Blue amp. AD value

37 38 39 40 41 42 43 44 45 46 47 48 49 50 Amplitude(R) 4 Red amp. AD value

HEX=LED ',' ',' CR LF LED 8 LED accumulated time

0 1 2 3 4 5 6 7

17 qs Request 'q' 's' ',' ',' CR LF 0xEF

0 1 2 3 4 5 6 7 8 9 10

18 qs,OK Response 'q' 's' ',' 'O' 'K' ',' ',' CR LF 0x29

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18

19 *serialnumber Request '*' 's' 'e' 'r' 'i' 'a' 'l' 'n' 'u' 'm' 'b' 'e' 'r' ',' ',' CR LF 0xA0

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

20 Response '*' 's' 'e' 'r' 'i' 'a' 'l' 'n' 'u' 'm' 'b' 'e' 'r' '=' ',' Serialnumber Max. unfixed Serial number

10

25 26 27 28 29

',' CR LF

0 1 2 3 4 5 6 7

21 dc Request 'd' 'c' ',' ',' CR LF 0x0C

0 1 2 3 4 5 6 7 8 9 10

22 dc,OK Response 'd' 'c' ',' 'O' 'K' ',' ',' CR LF 0x46

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

C0=F 'C' '0' '=' F=C0 coefficient ',' ',' CR LF C0 Max. unfixed DO C0 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

C1=F 'C' '1' '=' F=C1 coefficient ',' ',' CR LF C1 Max. unfixed DO C1 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

C2=F 'C' '2' '=' F=C2 coefficient ',' ',' CR LF C2 Max. unfixed DO C2 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

d0=F 'd' '0' '=' F=d0 coefficient ',' ',' CR LF d0 Max. unfixed DO d0 coefficient

coefficient 16 (Uchida et al. , 2010)

Amplitude

Blue light Red light Blue light

Physical value AD value LED

accumulated

timeRed light

Enter

sleep

mode

Temp.

[°C]

DO

[μmol/L]
Temp. DO

PhaseNo. Command Type Command format Data

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

✔

Checksum

Checksum

*serialnumber=S S=Serialnumber

✔ ✔ ✔

✔ ✔ ✔

Checksum

Checksum

stdona,HEX,

HEX,HEX,

HEX,HEX,

HEX,HEX

✔ ✔ ✔ ✔

Checksum

Data

length

Check-

sum
Description
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0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

d1=F 'd' '1' '=' F=d1 coefficient ',' ',' CR LF d1 Max. unfixed DO d1 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

d2=F 'd' '2' '=' F=d2 coefficient ',' ',' CR LF d2 Max. unfixed DO d2 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

d3=F 'd' '3' '=' F=d3 coefficient ',' ',' CR LF d3 Max. unfixed DO d3 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

d4=F 'd' '4' '=' F=d4 coefficient ',' ',' CR LF d4 Max. unfixed DO d4 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Cp=F 'C' 'p' '=' F=Cp coefficient ',' ',' CR LF Cp Max. unfixed DO Cp coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

e0=F 'e' '0' '=' F=e0 coefficient ',' ',' CR LF e0 Max. unfixed DO e0 coefficient

coefficient 16 (Uchida et al. , 2010)

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

FilmNo=S 'F' 'i' 'l' 'm' 'N' 'o' '=' S=Film Number ',' ',' CR LF Film 8 unfixed Film number

Number

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25

docaldate=S 'd' 'o' 'c' 'a' 'l' 'd' 'a' 't' 'e' '=' S=Calibration date ',' ',' CR LF Calibration 10 unfixed Date of DO calib.

date

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

A=F 'A' '=' F=A coefficient ',' ',' CR LF A Max. unfixed T. A coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

B=F 'B' '=' F=B coefficient ',' ',' CR LF B Max. unfixed T. B coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

C=F 'C' '=' F=C coefficient ',' ',' CR LF C Max. unfixed T. C coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

D=F 'D' '=' F=D coefficient ',' ',' CR LF D Max. unfixed T. D coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

E=F 'E' '=' F=E coefficient ',' ',' CR LF E Max. unfixed T. E coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

F=F 'F' '=' F=F coefficient ',' ',' CR LF F Max. unfixed T. F coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

G=F 'G' '=' F=G coefficient ',' ',' CR LF G Max. unfixed T. G coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23

H=F 'H' '=' F=H coefficient ',' ',' CR LF H Max. unfixed T. H coefficient

coefficient 16

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

tcaldate=S 't' 'c' 'a' 'l' 'd' 'a' 't' 'e' '=' S=Calibration date ',' ',' CR LF Calibration 10 unfixed Date of T. calib.

date

Phase Amplitude

Blue light Red light Blue light Red light

Check-

sum
Description

Physical value AD value LED

accumulated

time

Enter

sleep

mode

Temp.

[°C]

DO

[μmol/L]
Temp. DO

No. Command Type Command format Data
Data

length

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum
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0 1 2 3 4 5 6 7

23 wu Request 'w' 'u' ',' ',' CR LF 0xE7

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14

24 wu,State Response 'w' 'u' ',' 'n' 'o' 'r' 'm' 'a' 'l' ',' ',' CR LF State ="normal" 0x32

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

'w' 'u' ',' 'p' 'r' 'e' 'h' 'e' 'a' 't' ',' ',' CR LF State ="preheat" 0xD2

0 1 2 3 4 5 6 7 8 9 10 11 12 13

'w' 'u' ',' 's' 'l' 'e' 'e' 'p' ',' ',' CR LF State ="sleep" 0xA2

0 1 2 3 4 5 6 7 8 9 10 11

25 querys Request 'q' 'u' 'e' 'r' 'y' 's' ',' ',' CR LF 0x2A

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18

26 querys,State Response 'q' 'u' 'e' 'r' 'y' 's' ',' 'n' 'o' 'r' 'm' 'a' 'l' ',' ',' CR LF State ="normal" 0x75

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

'q' 'u' 'e' 'r' 'y' 's' ',' 'p' 'r' 'e' 'h' 'e' 'a' 't' ',' ',' CR LF State ="preheat" 0x15

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

'q' 'u' 'e' 'r' 'y' 's' ',' 's' 'l' 'e' 'e' 'p' ',' ',' CR LF State ="sleep" 0xE5

0 1 2 3 4 5 6 7 8 9 10

27 fwver Request 'f' 'w' 'v' 'e' 'r' ',' ',' CR LF 0xA9

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

28 fwver=S Response 'f' 'w' 'v' 'e' 'r' '=' S=Firmware version ',' ',' CR LF 8 unfixed Firmware version

0 1 2 3 4 5 6 7 8 9 10

29 model Request 'm' 'o' 'd' 'e' 'l' ',' Checksum ',' CR LF 0xC2

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

30 model=S Response 'm' 'o' 'd' 'e' 'l' '=' 'A' 'R' 'O' '-' 'F' 'T' ',' Checksum ',' CR LF S="ARO-FT" 0xDC

Max.

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 16

'm' 'o' 'd' 'e' 'l' '=' 'A' 'R' 'O' 'D' '-' 'F' 'T' ',' Checksum ',' CR LF S="AROD-FT" 0x98

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

31 boudrate=I Request 'b' 'a' 'u' 'd' 'r' 'a' 't' 'e' '=' '1' '4' '4' '0' '0' ',' Checksum ',' CR LF baudrate="14400" 0x55

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

'b' 'a' 'u' 'd' 'r' 'a' 't' 'e' '=' '1' '9' '2' '0' '0' ',' Checksum ',' CR LF baudrate="19200" 0x52

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

'b' 'a' 'u' 'd' 'r' 'a' 't' 'e' '=' '3' '8' '4' '0' '0' ',' Checksum ',' CR LF baudrate="38400" 0x4F

32 boudrate=I Response Same as Request

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

33 error Response 'e' 'r' 'r' 'o' 'r' '=' I=Error Code ',' ',' CR LF Error Code 4 unfixed Error code

Checksum

Model name

Firmware

version

Set baud rate

(default: 38400)

Phase Amplitude

Blue light Red light Blue light Red light

Check-

sum
Description

Physical value AD value LED

accumulated

time

Enter

sleep

mode

Temp.

[°C]

DO

[μmol/L]
Temp. DO

No. Command Type Command format Data
Data

length

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum

Checksum
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Appendix 3: Examples of Operation Sequence 

 

 

 

 

 

 

 

  

Power ON RINKO FT 

Start 

Wait 6 seconds 

Command “querys” 
 “preheat” 

“normal” 

Command “tdon” 

Store T, DO, LED time 

by host controller 

Command “querys” 

Power OFF RINKO FT 

End 

“sleep” or “error=0003” 

RINKO FT returns “error=0003” to the 

first command “querys” while it is in sleep 

mode, but it appropriately responds after 

“error=0003” (see Chapters 3 and 5 in 

appendix 1). 

We recommend waiting for 6 seconds for surely obtaining 

reliable DO data, although the preheat time is 5 seconds at 

minimum. 

Example 1: Sample T and DO at 10 s (or more) of sampling interval. 

It is much better to power on and off RINKO FT for each measurement to save energy.  In other words, 

please repeat the flowchart below during the observation.  It may take at least 7 – 8 s for single iteration, 

which depends on the host controller. 

We strongly recommend powering off 

RINKO FT instead of using sleep mode. 

The command “querys” is used for 

confirmation only and is not required 

to complete this flowchart. 
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Power ON RINKO FT 

Start 

Wait 6 seconds 

Command “querys” 
“preheat” 

“normal” 

Command “stdon” 

Store T, DO, LED time 

by host controller 

Command “qs” 
No response 

Power OFF RINKO FT 

End 

“OK” 

Repeat sampling? 
Yes 

No 

Example 2: Sample T and DO at 6 s (or less) of sampling interval. 

In this case, RINKO FT is necessary to be continuously powered on until the observation is finished as 

shown in the flowchart below. 

Minimum sampling interval is 1s. 

Note: RINKO FT automatically enters sleep 

mode if it does not receive any command for 

2 minutes. Once RINKO FT entered sleep 

mode, it requires 5 seconds to stabilize the DO 

output after waking up. See chapter 3. 

We recommend waiting for 6 seconds for surely obtaining 

reliable DO data, although the preheat time is 5 seconds at 

minimum. 



 

 

 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Manufacturer 
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